
Upgrading :  WO�dð

…¡U?H?� s� b¹e?²� »u?ÝU?(« v�≈ …b¹b?ł  U½uJ� W?�U?{≈

Æ Î«—uDð d¦�√ ÂUN� ¡«œ_ …eNł_«

Installation :  VOBMð

Æ »uÝU(« “UNł v�≈ ÊuJ� Í√ jÐ—Ë VO�dð

Format :  W¾ONð

`�???� r²¹ Y?O??×?Ð VKB?�« ’d??IK?� Âb??	???²???�ð W???OKL???Ž

v�≈ ’d?I�« rO�?IðË ’dI?�« vKŽ …œułu*«  U?�uKF*«

 lÞUI�Ë  «—U��

System Memory :  ÂUEM�« …d�«–

wB?	?A�« »uÝU?(« W?�uEM* W?O?�?Ozd�«  U½uJ*« s�

Æ  U½UO³�« s¹e	ð w� W�b	²�*«

Cache Memory :  W²�R� …d�«–

W??Žd?Ý …œU?¹e� Âb?	??²??�ð W??O?�U??{≈ …d??�«– sŽ …—U?³??Ž

Æ Z�UF*« ¡«œ√ …¡UH�Ë

System Case :  ÂUEM�« ‚ËbM�

WOKš«b�«  UI×K*«Ë WO½Ëd²J�ô«  U½uJ*« tKš«bÐ w½bF� ‚ËbM


Æ Â_« WŠuK�«Ë wB	A�« VÝU×K�

Printers :   UFÐUÞ

WKO?Ýu� Âb?	²?�ðË »uÝU?Š Í_ WO?�Ozd�«  U?I×K*« s� d?³²?Fð

Æ Ã«dš≈

Interrupt Request :  lDI�« VKÞ

W¹œU*«  U½uJ*« jÐd?ð w²�« ‰UB?ðô« ◊uDš Ÿ«u½√ s� Ÿu½ w¼Ë

c?O?HM²� Âb?	?²�¹Ë l?DI�« dDO?�� l?� WO?ł—U?)«

ÆWMOF� WLN� VKÞ

Mouse :  …—QH�«

w� Âb?	?²??�ð YO?Š ‰U?šœù« …e?N??ł√ s� b?Fð

—U???O??²???šô Ë√ W??ýU???ýô vKŽ d???ýR*« p¹d???%

d??BMŽ V?×??Ý Ë√ W??ýU??A�« vKŽ s?� d??BMŽ

Æ WýUA�« vKŽ s� 5F�

Hard Disk :  VKB�« ’dI�«

ÎU¹œuLŽ W³ðd�  U½«uDÝô« WŽuL−� sŽ …—U³Ž

s¹e?	²� Âb?	²?�ðË ‚ËbM
 sL{ …œu?łu�Ë —u?×� ‰u?Š

Æ Î«bł WO�UŽ WFÝ  «– w¼Ë UNOKŽ  U�uKF*«

Floppy Disk :  Êd� ’d�

…œU� s� WI³DÐ vDG� WOJO²ÝöÐ …œU� s� ŸuMB� ’d�

W?³K
 WOJO?²ÝöÐ W?I?³DÐ ÎUC¹√ vDG?� u¼Ë jMG?L²K� WKÐU?�

W?F�Ð u¼Ë t?OKŽ  U?�uKF*« s¹e?	²� Âb?	²?�¹Ë Æ t?²¹UL?(

Mg . ±[¥¥

CD - Rom :  ◊uGC� ’d�

s¹e?	ð W??F?Ý Ë– ·U?H?ý wJO?²??ÝöÐ Ídz«œ ’d?�

Æ tOKŽ W½e<«  U�uKF*« dOGð sJ1 ôË WO�UŽ

Mother Board :   Â_« WŠuK�«

WOzUÐdNJ�«  öO
u²�« tOKŽ ”öłd³OH�« …œU� s� Õu�

Æ VÝU×K� W½uJ*« WOÝUÝ_« WO½Ëd²J�ô« ¡«eł_«Ë

External Modem :  wł—Uš Âœu�

WDÝ«u?Ð »u??ÝU??(« v�≈ ◊u?Ðd??� d??O??G???
 ‚ËbM


◊uÐd?� W??O½U?¦�« W??N?'«Ë W??N?ł s� q�K�??²?� q³??O?�

Æ nðUN�UÐ

dðuO³L~!« Z"«dÐ

—UO)« ·UI¹≈

wwwwKKKK????ŽŽŽŽ    5555����UUUU????EEEE½½½½    qqqqOOOO????????????????LLLL????????????????××××????????????????²²²²ÐÐÐÐ    XXXXLLLL????????????????����    ºººº

ssssJJJJ����ËËËË    UUUU????LLLL¼¼¼¼bbbb????ŠŠŠŠ√√√√    ····cccc????××××ÐÐÐÐ    XXXXLLLL????����ËËËË    ÍÍÍÍ““““UUUU????NNNN????łłłł

rrrrÝÝÝÝ≈≈≈≈    dddd????????????NNNN????EEEE¹¹¹¹    ““““    UUUU????????????NNNN????????????''''««««    qqqq????OOOO????????????GGGG????????????AAAAðððð    bbbb????MMMMŽŽŽŽ

    ««««————UUUU????????????????OOOO????????????????²²²²????????????????ššššôôôô««««    wwww����    ····ËËËËcccc????????????????;;;;««««    ÂÂÂÂUUUUEEEE????MMMM����««««

øøøø    tttt����cccc××××ÐÐÐÐ    ÂÂÂÂuuuu����««««    nnnnOOOOJJJJ����

s?� —U?????O??????)« ·c??????Š o¹d?Þ sŽ p?�– r²?¹

`²HÐ p�–Ë ÂUE?M�« b¹b×²� W?OÝUÝ_« W?LzUI�«

vKŽ œułu*« nK*«

s�Ëboot.ini  rÝùUÐc:  wÝU?Ý_« ’dI�«

Íc�« dD��« ·cŠ r²¹ nK*« «c¼ ‰öš

UM?MJ� ¨ ·Ëc???;« ÂUEM?�« rÝ√ v�≈ d???O???A¹

«c¼ s� WOÞUO²Š≈ W	�½ qLFÐ ÎôË√ `BM½

TD	?ð b??� Ë√ ÂUEM?�« dŁQ??²¹ ô v²???Š nK*«

d³²F¹ nK*« Ê√ U0Ë ÆÆ ·c(« WOKLŽ w�

ôË ÷u????N?M�«  U????H?K� s?L????{ s�Ë r?N????�

nAJ?²??�??� ‰ö???š s� t??�U??A???²??
≈ lOD?²??�ð

t?¹d¹d???????×??????²?�« Z�«d??????³?�« s?� Í√ Ë√ “ËbM?¹Ë

Ë√ ÎU???O???H????	???� ÊuJ?¹ b???� «c� …dJ?H*« WD?Ý«uÐ

‰ušb�« ÎôË√ÆÆ s�×²�O� jI� …¡«dIK� ÎUOL×�

s�Ë ¡b?³�« W?LzU?� s�dos  t?łu?� Z�U½dÐ v�≈

‰u?????šb�« Ë√command  d?????�_«  WÐU?????²?????
 rŁ

r²¹Ë © qO??G??A?²�« ¡bÐ ’d??�® w�UE½ ’d??IÐ

Æ WLOK��« WI¹dD�UÐË —u
c*« nK*« d¹d%

° qOL×²�«  w	 WKJA�

∫ ‰«u¾��« ÂuNH� 

ÆÆÆÆÆÆÆÆÆÆÆÆ    wwww³³³³????ŽŽŽŽdddd????AAAA����««««    bbbb????LLLL????××××????����    ‚‚‚‚————UUUUÞÞÞÞ    ŒŒŒŒ____««««        ºººº

XXXXLLLL????????????����    pppp½½½½QQQQÐÐÐÐ    pppp????����««««RRRR????????ÝÝÝÝ    ssss����    ÁÁÁÁUUUU????MMMMLLLL????????NNNN????????????����    UUUU////≈≈≈≈

““““UUUU????????????????????NNNN????????????????????''''««««    ffffHHHH????½½½½    vvvvKKKK????ŽŽŽŽ    5555����UUUU????EEEE½½½½    ‰‰‰‰««««eeee????½½½½SSSSÐÐÐÐ

xp    ÂÂÂÂUUUUEEEEMMMMÐÐÐÐ    WWWW����UUUU))))««««    WWWW????����UUUUÝÝÝÝdddd����««««    pppp����    ddddNNNNEEEEððððËËËË

xp    ÂÂÂÂUUUUEEEEMMMMÐÐÐÐ    ’’’’UUUU))))««««    ————UUUUOOOO))))««««    ————UUUUOOOO²²²²šššš≈≈≈≈    bbbbFFFFÐÐÐÐ

∫ w�U²�U


windows could  not start because
the following file is missing

or corrupt:
windows\system32\config\system\

you can attempt to repair this file by
starting windows setup using
the original setup cd- rom

select ,r, at the first screen to start
repair

dDÝ —U??O??²??š√Ë ÆÆ qO??G??A?²?�« W?O?KL??Ž bMŽ

WKJA?LK� UM¹b� Í√d�«U?�  winxp     ‡� —U?O)«

∫ wK¹ UL
 u¼

∫ W�UÝd�« vMF�

…………————uuuu????????????



cccc****««««    WWWW����UUUU????????????ÝÝÝÝdddd????����««««    tttt????????OOOO????MMMMFFFFðððð    UUUU????????????����    ôôôôËËËË√√√√

wwww����    ¡¡¡¡bbbb????????????????³³³³????����««««    ““““ËËËËbbbbMMMM????¹¹¹¹ËËËË    llllOOOODDDD????²²²²????????????????����¹¹¹¹    ôôôô    tttt????½½½½QQQQÐÐÐÐ

ÊÊÊÊ____    qqqqOOOOGGGGAAAA²²²²����««««

s� u¼Ë U???H�Uð Ë√ «œu??I??H??� U??�≈ n?K*« «c¼

system bK:« sL{ …œułu*«  UHK*«

w� d????
– rŁ —u???
c*« —U????�*« s� Ÿd???H????²*«

Ác¼ Õö????�≈ sJ1 t?½√ W�U???Ýd�« Êu????L???C???�

WKJA*«

s� qO??G?A?²�« Ë√ qO??L?×?²�« ¡b?Ð o¹dÞ sŽ

w� Õd?²I¹ rŁ W?OK�√ W	?�½windows  ÂUE½

Í√R  ·d?Š vKŽ j?G?C�« W�U?Ýd�« Êu??L?C?�

…œU???Ž≈ r²¹ U???NM?O??ŠË Õö???�ù« ¡b???³�repair 
¡bÐË qOGA²�«

Æ „“UNł w	 qDF�« Õö�≈

∫ WKJA*« V³Ý 

XL� p½√ U0— wN� WK?JA*« w� V³��« U�√

wN²Mð r� Ë√ t�c×Ð XL� rŁxp  ÂUE½ W�U{SÐ

v�≈ Èœ√ U2xp  oÐU??��« qO?L??×??²�«  W?OKL??Ž

ÂUE?M�«  U??H?K� Y¹b???%Ë —U??O???)« «c¼ l{Ë

’d?I�« VKD¹Ë h�U½ ÂUE½ vKŽ tÐ ’U?)«

Ê–≈ q(«Ë ÂUEM�« Y¹b?%Ë …œUŽù ◊u?GC*«

q¹eMð …œUŽSÐ ÂuIð Ê√

ÂUEM�«  U?HK� Y¹b?%Ë Èd?š√ …d?� ÂUEM�«

—UO)« «c¼ W�«“≈ b¹dð XM
 «–≈Ë WOÝUÝ_«

Ÿułd�« s?J1 Èdš√ …d� p?� œuF¹ Ê√ ÊËœ

t?O??�UM×??{Ë√ Íc�« ‰Ë_« ‰«R?��« WÐU??ł≈ v�≈

dDÝ ·cŠ WOHO


 ·Ëc;« ÂUEMK� d�«Ë_«

xp ”ËbM¹Ë VOBMð

øøøøXP    ““““ËËËËbbbbMMMM¹¹¹¹ËËËË    VVVVOOOOBBBBMMMMðððð    WWWWIIII¹¹¹¹ddddÞÞÞÞ    wwww¼¼¼¼    UUUU����

øwindows xp VOBM²� ‚dÞ …bŽ rJ¹b�

“ËbM¹u� ◊u?G?C*« ’d?I�« Â«b?	?²?ÝUÐ ©±

Bootable ÊuJ¹ Ê√ V−¹ t½√ …UŽ«d� l�XP 
bMŽ Ÿö�ù« w� ‰Ë_« u¼cd-rom  ÊuJ¹ Ê√ Ë

s� p�– w� rJ×²�« sJ1 Ë ¨ “UN'« qOGAð

w� ”u?O??³�«  «—U?O?š w� d??O?O?G??²�« ‰ö?š

pOKŽ U� q
 p�– bFÐ ¨Boot sequence  bM³�«
qG??A?� w�xp  ÂUEM�« ’d??� lCð Ê√ u¼

qL?F?OÝ Ë “U?N?'« qO?G?Að bO?Fð Ë ’«d?�_«

u¼ pOKŽ U?� q
 Ë U?OzU?IKð V?OB?M²�« Z�U½dÐ

s?� …œ—«u�« q?zU?????Ýd�«Ë  «œU?????ý—ù« ŸU?????³?ð≈

Æ ÂUEM�«

V³???Ý Í_ v?�Ë_« W???I¹dD�« X?KA???� «–≈ ©≤

’d� Í√ Â«b	²ÝUÐ “UN'« qOGAð p½UJ�SÐ

Ë ◊uG?C*« ’dIK� rŽœ l� ”Ëœ qO?GAð

Áb???& Íc�« Ëwinnt.exe  Z�U?½d????³�« qG????ý

qš«œ

win- ◊u?G?C?*« ’d?I�« w�i386  bK:«

dows xp .
W???	??�½ “U???N??'« v?KŽ p¹b� ÊU???
 «–≈ 3) 
Ë√NT4  Ë√W9x  “Ëb??M??¹u??� Èd?????????????????????š√

VOBM²K�win2000 
set- Z�U½d??³�« qO??G??A??²Ð r�XP  “ËbM¹Ë

◊uGC*« ’d?I�« w� Áb& Íc�« Ëup.exe 

“ËbM¹uK�

Ëwinnt32.exe  nK*« q?O?G??A??²Ð Ë√XP 
Ác¼ w� Ëi386  b?K:« q?š«œ Áb??????& Íc?�«

W�U(«

Âu????I?ð Ê√ U????�≈ Ê«—U????O????š p?¹b� ÊuJ?O????Ý

“Ëb?M¹u?�« ‚u?????�XP  “Ëb?M¹u?�« VO?????B?M²?Ð

Ë√ ¨ .bI�«

Ë qI??²?�??� qJAÐXP  “ËbM¹u�« V?O?BMð

VO????BM?²�« ¡U????N½≈ b????FÐ Ë W?�U???(« Ác?¼ w�

p� dNEOÝ

∫ Ê«—UOš U?NO� WLzU� “UN?'« qOGAð bMŽ

UNM� —U²	ð .bI�« “ËbM¹u�« Ë√XP  “ËbM¹Ë

ÆÆ tKOGAð b¹dð Íc�« ÂUEM�«

∫ �b���zU"
ÊÊÊÊ√√√√    qqqqCCCCHHHH¹¹¹¹        UUUU³³³³����UUUUžžžž    ÂÂÂÂbbbb				²²²²����****««««    ÍÍÍÍeeee¹¹¹¹eeeeŽŽŽŽ

““““ËËËËbbbbMMMM¹¹¹¹uuuu����««««    VVVVOOOOBBBBMMMM²²²²ÐÐÐÐ    ÂÂÂÂuuuuIIIIðððð

VBM*« r?�?I�« d??O?ž d??š¬ r�??� vKŽXP 
«–≈ Ë  qš«b??²K� U??FM� .b??I�« “Ëb½u�« t??OKŽ

ô≈ p?¹b� Êu?J?¹ ô ÊQ?Ð p�c?� «d?DC????????� XM?


t????L???O????�???Ið s?� sJL????²ð r?� Ë b???Š«Ë r�????�

Â«b	²ÝUÐ

b??????� U?¼bM?Ž ¨Partition Magic  Z�U?½dÐ

Outlook qO??G??Að w� q
U??A*« iFÐ b??&

Express
q
U???A*« Ác¼ q?( Ë .b??I�« “Ëb?½u�« w�

bK:« s�  UHK*« iFÐ a�½ pOKŽ ÊuJOÝ

Win- b???K????:« v???�«WinntSystem32 
 U??HK*« Ác¼ v�« ·d??F??²K� ËdowsSystem 

v�« V¼–«

ËOutlook Express >Help>About 
w²�«  U??HK*« ¡U??L?ÝQÐ W??LzU?� b??−?²??Ý „UM¼

pOKŽ

W??ŠU?²??� X½U??
 w²�« W??I¹dD�« U??�√ ÆU??NKI½

¥ œ«bŽSÐ q¦L²ð w²�« Ë ≤∞∞∞ “ËbM¹Ë ÂU¹√

sŽ V?O?????BM?²�« ¡«d?????ł≈ Ë WM?O� ’«d?????�√

xp.. “ËbM¹Ë w?� W?ŠU??²??� b??Fð rK� U??N??I¹dÞ

W??????OK?L??????Ž w� ÂU?EM?�« tÐ e??????O?9 U?????� «c?¼Ë

Æ Y¹b(« VOBM²�«

n�u²�« WýUý 

WWWW????????????ýýýýUUUU????????????????ýýýý    ttttÐÐÐÐ    bbbb????????????????łłłłuuuuðððð    ôôôô    ÍÍÍÍ““““UUUU????????????????NNNN????????????łłłł    ºººº

UUUUNNNN²²²²����UUUU{{{{≈≈≈≈    llllOOOODDDD²²²²ÝÝÝÝ√√√√    nnnnOOOO



    WWWWOOOOLLLLÝÝÝÝ««««    nnnn����uuuuðððð

øøøø

W�U?Š w� d?NEð W?O?L?Ýù« n�u?²�« W?ýU?ý

W?�U{≈ e?�— s� rJ×?²�« WŠu� s?� UN?²�U?{≈

“ËbM¹Ë  «œ«b??Ž≈ —U??O??š s� Z�«d??³�« W�«“≈Ë

r²¹ n�u?²�« W?ýU?ý W?I?×K*« Z�«d?³�« s� rŁ

l{Ë

W??ýU??A�« sL??{ lÐd?*« vKŽ `� W??�ö??Ž

ÆÆ WOLÝù«

WOðU�uKF*« Q³M�« WJ³ý
http://www.annabaa.org/

—U??³??š√ ÍËU?Š W??OðU??�uK?F*« Q??³M�« WJ³??ý l�u??�

W?�U??×?�Ë Âö?Ž√Ë U??O?�U??IŁË U?O?ÝU??O?Ý W??ŽU?��«

’u???????B?½Ë  ôU??????I???????�Ë ÆÆ »U?¼—ù«Ë n?MF?�«Ë

dJH�« U¹U?C?I?� »«uÐ√Ë ÆÆW¹œU?B?²?�≈Ë W?O?ÝU?O?Ý

Æ wÐdF�«

Õ«uÝ
http://www.swaah.com/

·—UF*« s� d?O³
 œbŽ w� W?ŠUO��UÐ r²N¹Ë Õ«u?Ý l�u�

Z�«d?³�«Ë  U?ŽuM*«Ë W¹dðu?O?³?LJ�«Ë W?OMI?²�«Ë W?O?�U?I?¦�«

W?O?�ö?Ý≈ l�«u??�Ë W?O?B?	?ý  U?×?H?�Ë ¨ W?O?L??OKF?²�«Ë

ÆWO{U¹— l�«u�Ë ÆÆ ‰ULŽ√Ë ‰U�Ë —U³š√Ë

YOK¦ð

http://www.tathleeth.net/links/
tasali/

»«uÐ_« r?¼√Ë W???ŽuM?*« l�«u*« s?� u¼Ë

r¼_ qO�œË  U?ŁœU?;«Ë  U¹b??²M*« t??O?�

Æ WO{U¹— —U³š√Ë w�U�ðË ¨ l�«u*«

 wÐdF�« —uD*«
http://www.arabbuilder.com/  

wÐd??F�« Z�d?³*U?Ð r²?N¹ ¨ Èb??²M�Ë wÐd?Ž l?�u?�

Z�«dÐË l�«u*« s� œb?F� W?F¹d?Ý  ö?�Ë t?O?�Ë

«c¼ w� b¹b??'« p�– s� r¼√Ë  U½U?O?³?�« b?Ž«u?I�

Z�«d????³?�«  «—«b????�« d????šô W????FÐU????²????�Ë l?�u*«

ÆÆWŽuM*«

 �UÖuðË√ ÜKFð 
iFÐ ¡U??A½≈ qB??H�« «c¼ w� rKF??²?²??Ý

w¼Ë ¨œU??�uðË√ w� W?O??ÝU?Ý_«  U?MzUJ�«

rKF?²ðËline) ® j)«Ëpoint) ® WDIM�«

 UMzUJ?�« W?O??IÐ rÝ— ÂœU??I�« ”—b�« w�

…dz«b�«Ëarc) ® ”uI?�« w¼Ë WO?ÝUÝ_«

w?¼Ë  UM?zUJ?�« W?????O?????IÐ U?????�√circle). ®
d?O?ž  UMzU?� ÊQÐ U?N?H?�Ë sJ1  UMzU?�

s� W?³??�d?� ÊuJð Ê√ U?�≈ wN?� W??O?ÝU?Ý√

œb????F???²????� q¦????� W???O????ÝU????Ý_«  UMzU?J�«

W????K????²????J????�«Ëpolyline) ® ◊u????D????)«

ÍœR?¹Ëhatch) ® q?O?K??E?²?�«Ëblock) ®
U¼d?�U?MŽ v�≈ U?NJO?JHð Í√® U¼d?O??−?Hð

d?O?³?� œb?Ž vK?Ž ‰u?B?(« v�≈ ©W?O�Ë_«

”«u??????????
_«Ë ◊u?D?)«Ë ◊U?????????I?M?�« s?�

sJ?1  UMzU????� ÊuJð Ê√ U???�≈Ë ¨d?z«Ëb�«Ë

W?�œU??I�« ”Ë—b�« v�≈ U??N?²?Ý«—œ qO??łQð

YOŠ s� WO½U¦�« W?Š—b�« w� wðQð UN½u�

s� W?³?�d?� U?N?LEF?� w� w¼Ë ¨W?O?L¼_«

Î«–≈ ÕU?²?% Æp�c?� W?O?ÝU??Ý_«  UMzUJ�«

Î̈«b??O???ł W??O??ÝU??Ý_«  U?MzUJ�« r?N??� v�≈

 ÆZ�U½d³K� ÍdIH�« œuLF�« UN½_

œU???
uðË√ d??�«Ë√ v?�≈ ‰u??�u�« s?J1

d??O???žË …d??ýU???³??� ¨…b¹b???Ž ‚dÞ d???³??Ž

wN??� …d?ýU??³*« ‚dD?�« U?�√ Æ…d??ýU?³??�

œU????
uðË√ …c????�U½ w?� d???�«Ë_« ‰U????šœ≈

‰U?šœ≈ Ë√® `OðU?H*« W?Šu� Â«b	?²?ÝUÐ

¡UI?²½« Ë√ ¨©ÎUF?³Þ UN?� dB²?<« rÝô«

ÊUðU?¼Ë ¨œU???
u?ðË√ W???L?zU???� s� d????�_«

s� œU
uðË√ w?� ÊU²�Ëd?F� ÊU²?I¹dD�«

qC??H¹ iF??³�« ÊU??
 Ê≈Ë ¨b??O??FÐ s�“

s� tzU?I²½« s� d?¦
√ Áb?OÐ d�_« WÐU?²


WI¹dD?�« Ác¼ t×M9 U* Î«dE½ ¨W?LzUI�«

W?¦�U¦�« W?I¹dD�« U?�√ ÆWO�U?Ž WŽd?Ý s�

d?�_« p�– q¦1 Íc�« —e�« ¡U?I²½« wN?�

 √bÐ W?I¹d?Þ w¼Ë  «Ëœ_« j¹d?ý s�

¨œU?
uðË√ s?� ±≥ …—«b?�ù« l� ÎU?O?KF?�

Âu???Ýd�«®  U½u???I¹_« rEF???� X�«“ ôË

—u??????B?�« fH?½ q?L??????% ©—«—“_« vK?Ž

d??³??FðË Æ…—«b??�ù« pKð c?M� W??IÐU??��«

qO?GA?²�« ÂUE½ ÕË— sŽ W?I¹dD�« Ác¼

sŽ d�«Ë_« …c�U½ d?³Fð ULMOÐ ¨“ËbM¹Ë

p�c?�Ë Æ”Ëœ qO????G????A????²�« ÂU?E½ ÕË—

w� d???�«Ë_« …c??�U?½ wH???²??	ð Ê√ s?J1

sJ�Ë ¨œU
uðË√ s� W�œUI�«  «—«b�ù«

ÆÎU³¹d� fO�

“UF¹ù« wN� …dýU?³*« dOž ‚dD�« U�√

s� d?????�«Ë_« c????O????H?M²?Ð œU????
u?ðË√ v�≈

Ë√scripts) ® W??O???−??�d??³�« ’u???BM�«

œU?
uðË√ l� qLF?²� WL?LB*« Z�«d?³�«

ÊËœ œU??
uðË√ W??³ÞU??	0 Âu?I?ð w²�«Ë

lO?D²???�ð l³?D�UÐË ¨p?�cÐ d???F???Að Ê√

Z�«d????³�«Ë W???O????−???�d????³�« ’u???B?M�«

U0— p?M� Ÿd??Ý√ œU???
uðË√ W???³ÞU??	???�

pð—U??N??� X?GKÐ U??L??N??�  «d?*«  U??¾0

p�– w?� qF?�Ë ¨ÊQ????ý s?� p²?????Žd????ÝË

rK?Fð w?� ÎU¹b????ł d????OJH????²K?� p� …u????Žœ

Îö??¦??� »d??ł ¨W??−??�d??³�«  U??G� Èb??Š≈

«c?¼ w� œu???????łu?*«VBA  r?KF?ð …—Ëœ

Æl�u*«

∫ rÝd�«  «Ëœ√ j¹dý 

·d??F??²�« p?OKŽ ¨rÝd�« √b???³ð Ê√ q³??�

”—b�« ≠  U?MzUJ�« V?ŁË  «—U??O???š

Æ©lÐU��«

¡U?A½« WI¹dÞ w�U?²�« bN?A*« q¦1

b?¹b??????×??????²?Ð œU??????
u?ðË√ w� W?D?IM?�«

∫…—QH�« Â«b	²ÝUÐ UNF�u�

Command: point
Current point modes:
PDMODE=0 PDSIZE=0.0000

…—QH�« —e?Ð dI½«Specify a point: 
w?� d??????????????�?¹_«

Íc????�« l?????�u????*«

 b¹dð

Command
: 

b????N????A?*« U????�√

q¦??L??O??� w�U??²�«

¡U????????A?½« W????????I?¹d?Þ

œU
uðË√ w� WDIM�«

U??N?F??�u?� b?¹b?×??²Ð

‰U????????????????????????????????šœS???Ð

 U???????????O??Ł«b???????????Šù«

W?I?KD*« W?O?ð—UJ¹b�«

ÂU?E½ r?N?????� ∫lł«—®

≠  U????????O?Ł«b????????Šù«

¨©w?½U????????¦?�« ”—b?�«

W?????D?????I????½ r?????Ýd?????�

U????????NðU????????O?Ł«b???????Š≈

∫©µ∞∞\±∞∞∞®

Command:  

point
Current

point modes:
PDMODE=0
PDSIZE=0.0

000
Specify a
point:500,10

00
Command
s� d???�√ —«d?Jð

œU??
uðË√ d??�«Ë√

 ∫
X?E?Šô p??K?F?�

WD?I½ d????�_« Ê√

W??D???I??½ r???Ýd??¹

«–≈Ë ̈ …b??????????Š«Ë

ÎU???????³???????ž«— XM?


pOK?Ž ÊS??� WDI?½ s� d??¦???
√ rÝdÐ

q¼ sJ�Ë ¨ «d?� …b?Ž d?�_« —«dJð

œU?
uðË√ d?�«Ë√ —«dJ²� WKO?ÝË s�

s� tzUI?²½« …œUŽ≈ s� ÎôbÐ W?Žd�Ð

Ë√ W?????LzU?????I�« Ë√  «Ëœ_« j¹d?????ý

d?�«Ë√ …c?�U½ w� b¹b?ł s� t²ÐU?²?


øœU
uðË√

jG?C�UÐ p�– sJ1 ¨rF½ »«u?'«

sŽ »uM?¹Ë ¨‰U??šœù« ÕU??²??H??� vKŽ

s1_« …—Q?????H�« —“ v?KŽ d?????IM?�« p�–

d???�_« c???O???HMð s?� ¡U???N??²?½ô« b???FÐ®

d????�«Ë√ W?¹QÐ ¡b????³?�« q³????�Ë l?³D?�UÐ

bŽU�*« d�_« Â«b	²ÝUÐ Ë√ Æ©Èdš√

sŽ W¹«b³�« w?� p�Q�¹ Íc�«multiple 

¨rÝd?�«  «Ëœ√ j¹d?????ý v�≈ V?¦?????
 sŽ

¨…b¹b??Ž  «d??� t?�b??	??²?�??²??Ý Íc�«Ë

”—b�« v�≈ Ÿu?łd�« p?OKŽ ÊU?
 U0—Ë

WÞd?ýQÐ rJ×²�« W?O?HO?
 W�d?F* ‰Ë_«

 Æ «Ëœ_«

WÞd?ýQÐ rJ×??²�« W?O?H?O?
 W?�d?F* ™ 

Æ‰Ë_« ”—b�« lł«—  «Ëœ_«

zero ) ®—e�« d???I?½« WDI½ r?Ýd�  ™ 

V²???
« Ë√ ¨rÝd?�«  «Ëœ√ j¹d???ý s�

…c?�U½ w�point 
œU??
u?ðË√ d??�«Ë√

po  V?²???????
« Ë√®

Î«—U??????B???????²??????š«

o?²?½« Ë√ ¨©p?�c?�

Draw>Point
>Single

W????L?zU????� s�Point 
œU
uðË√

j¹dý ∫©±® qJA�«

ÆrÝd�«  «Ëœ√

j?¹d?????ý n?�Q?????²?¹ 

s??� r???Ýd??�«  «Ëœ√

rK?Fð pO?KŽ ¨Î«—“ ±∂

w?� U?????N?M� s?¹d?????�√

w??¼Ë ”—b???�« «c??¼

Æj)«Ë WDIM�«

∫ WDI½ rÝ—

s?zU?????
 WD?IM?�«

f??O?� w??Ýb?M??¼

«c¼Ë ¨œU???F?Ð√ t�

«–U* d???�??H?¹ U??�

W?DI?M?�« vI??????³?ð

œU???????????
u?ðË√ w?�

Î«b???ł …d???O??G???�

XL?????� U????L????N????�

U?NM� »«d?²?�ôUÐ

d�_« Â«b	²ÝUÐ

d?O?³JðØdO?G?Bð

Íc?�«zoom)  ®
w� tOK?Ž X�dFð

‰Ë_« ”—b??????????�«

—U??×Ðù« ∫lł«—®

≠ r????Ýd????�« w????�

Æ©‰Ë_« ”—b�«

…b?zU?????????� U??????????�

w???� W???D????I???M???�«

sJ1 øœU???
uðË√

Â«b???????	??????²???????Ý«

l?łd?????????L????????
 œU?????????
u?ðË√ w?� WD?I?M?�«

¡U??A½≈ w?� b??FÐ U??L??O??� t???�«b??	??²??Ýô

U?N?�«b??	?²?Ý« sJ1Ë ¨…b¹b??ł  UMzU?


p�–Ë  U?????ŠU????�*« q?OK?Eð w� ÎU?????C¹√

◊U??IM�« s� …d??O??³??
 W??Žu??L??−??� rÝdÐ

qš«œ W?LE²M� d?Ož W?I¹dDÐ …b?ŽU³?²*«

fO� w½U¦�« Â«b?	²Ýô« s?J�Ë ¨WIDM�

Ê√ sJ1 œU??
uðË√ Ê_ ¨l³D�U?Ð ÎU?OKL??Ž

U?????�b?MŽ p?M?Ž WÐU?????O?M�U?Ð p?�cÐ Âu?????I?¹

w²?�« qO?KE?²�« ‘u?????I?½ Âb?????	?????²?????�ð

ÆW�œUI�« ”Ë—b�« w� UNOKŽ ·dF²MÝ

Â«b??	??²??ÝUÐ WD?I½ v�≈ VŁu�« p?MJ1

VŁË  «—U?????O?????š s�Node  —U?????O????)«

≠ …b???I??Ž v�≈ V?Łu�« ∫lł«—®  UM?zUJ�«
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ÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆ∫∫∫∫    WWWWMMMMNNNN****««««
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ÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆ

∫∫∫∫    wwww????????½½½½ËËËËdddd????????????????????????????????????????????????????????????????????²²²²????????JJJJ????����ôôôô««««    bbbb????????¹¹¹¹dddd????????????????????????????????????????????????????????????????????³³³³????????����««««

ÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆÆ

ÊÊÊÊuuuu????³³³³????????žžžždddd¹¹¹¹    ssss¹¹¹¹cccc����««««    ¡¡¡¡UUUU????????����bbbb????����ôôôô««««        ºººº

rrrr????????NNNN????????MMMM????????¹¹¹¹ËËËËUUUU????????MMMM????????ŽŽŽŽ    dddd????????????????????????????????????????????????????????????????????????????AAAA????????½½½½    wwww????????����

ssss
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s?� Á—«dJ?²?Ð Vžd?ð Íc?�« d??????�_« r?Ý«

p�– qO?GA²Ð u¼ Âu?I¹ rŁ ¨n�uð ÊËœ

t?M?� V?K?D?ð Ê√ v?�≈ Á—«d?J?ðË d??????????�_«

ÕU?²H?� vKŽ jGC�UÐ p�– sŽ n�u?²�«

Æ`O?ðU?????H*« W?????Šu?� s�Esc  »Ëd?????N�«

Â«b	²?Ý« WOHO
 w�U?²�« bNA*« q¦1Ë

∫Îö¦� ◊UI½ WŁöŁ rÝd�multiple  d�√

 

Command: multiple
 

Enter command name to re-
peat: point

Current point modes:
PDMODE=0 PDSIZE=0.0000

…—Q?H�« —eÐ d?I½«Specify a point: 
b¹dð Íc�« l�u*« w� d�¹_«

POINT
Current point modes:

PDMODE=0 PDSIZE=0.0000
…—Q?H�« —eÐ d?I½«Specify a point: 

b¹dð Íc�« l�u*« w� d�¹_«

POINT
Current point modes:

PDMODE=0 PDSIZE=0.0000
…—Q?H�« —eÐ d?I½«Specify a point: 

b¹dð Íc�« l�u*« w� d�¹_«

POINT
Current point modes:

PDMODE=0 PDSIZE=0.0000
Specify a point: *Cancel*

Command:
w�  «—UO?š …bŽ œu?łË XEŠô pKF�

Ác¼ q?L???Að ¨Draw>Point W???LzU???I�«

rÝd�Single Point  d??�_«  —U??O??)«

Multiple Point d?�_«Ë ¨…œdH?� WDI½

¨◊U?I½ …b??Ž rÝd� Âb?	?²??�¹ d?�√ u¼Ë

ÆqOK� q³� UMKF� UL


Single Point w?L?????�?½ ô√ q?C?????H?¹

Ác?¼ Ê_ ¨d?????????�«Ë√Multiple Point Ë
d�«Ë√ v�≈ d?OAð W?OŠöD�« ¡U?LÝ_«

d?IM�UÐ c?HMð w²�« W?O?I?O?I?(« œU?
uðË√

t?³??Að w¼Ë Æ„«– Ë√ —U?O??)« «c¼ vKŽ

¨ «Ëœ_« j??¹d????????????????????ý —«—“√ p??�– w??�

WÞd????ý√ —«—“√Ë rz«u???I�«  «—U????O???	???�

d??�«Ë√ c??O?H?M²� Î«–≈ W??−?�d??³??�  «Ëœ_«

lO?D²?????�½ w²?�« W????OK?š«b�« œU?????
uðË√

W?OI?O?I(« U?NzUL?Ý« WÐU?²JÐ U?NKOG?Að

Multiple —U?O??)« Æd?�«Ë_« …c??�U½ w�

qG???A¹ YO???×Ð Z�d???³??� Îö???¦??�Point 
poin d�_« rŁmultiple  d�_«

X½ œUÐbMÝ

http://www.sendbad.net/countries/
morocco.html

YO??Š W?OÐd??G?� l?�«u?� s¹ËUM?F� q�U?ý l�u??�

r�«u?F�«Ë Êb?LK� Ê«uMŽ WzU?� s� d?¦?
√ rC¹

 U??O??F??L??'«Ë W¹b½_«Ë  ö??:«Ë n×??B�«Ë

ÆWOB	A�« l�«u*« s� p�– dOžË W�œ_«Ë

f½√ uÐ√
W??L?łd??²*« ”Ë—b�« s� WK�K?Ý vKŽ Íu?²??×¹

Âb?????I¹Ë ÆÆ µ r?�— »u????ýu?ðu?????H�« Z?�U½d?Ð s�

«c¼ ‰u??Š W?O?�u??Ýd�« ”Ë—b�« s�  «d?A??F�«

Æ dONA�« Z�U½d³�«

©s??#U??????????????????¦??$« ��b??$«® �u???????????????"U????????????????I?!« s??"

π∏ �Ëb½Ë w' WÐuDF*«  UHK*« Õö)≈
w� ÎU?H�Uð ÎUHK� „UM¼ Ê√ b?
Q²?�file ddl  ‰uIð Q?Dš W�UÝ— p� d?Nþ√Ë dðuO³?LJ�« VO−?²�¹ r�Ë  U?HK*« iFÐ `²?� X�ËUŠ Ê≈

l{Ë b?FÐ t�?H½ ÂUEM�« v�≈ ‰u?šb�« wG?³M¹ d?š¬ nK� Í√ …œUF?²?Ý« Ë√ tðœUF?²?Ý« Ë√ tŠö?�ùË π∏ “Ëb½Ë qO?GA?²�« ÂUE½

∫WO�U²�«  «uD)UÐ r� rŁ W�U)« W×²H�« w� π∏ “Ëb½Ë ÂUEMÐ W�U)« W½«uDÝô«

w� ÂUEM�U?Ð ’U?)« bK:« p�U?�√ d??NEO?�Start/Programs/Accessories/System Tools/System Information  d??²?š« 

π∏[ “Ëb½Ë

V½U−Ð …d?OG?B�« …dz«b�« qOKE²Ð r� ¨ UM¼Ë …b¹b?ł …c�U½ d?NE²�Checker File Tools/System  d²?š« WIÐU�?�« …c�UM�« s�

«–S?� W?ÐuDF*«  Ë√ …œu?I??H*«  U?HK*« s?Ž Y×?³�« W??OKL?Ž √b??³ð wJ�Start  —e�« vKŽ j?G?{« rŁScan for altered files  d?�_«
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